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Vectorizing	text	basically	means	converting	text	to	a	vector	shape.	Depending	on	how	you	created	the	text,	there	are	different	ways	to	vectorize	text	in	Adobe	Illustrator.	In	this	tutorial,	youll	learn	how	to	vectorize	text	in	Adobe	Illustrator	in	three	ways.	Some	of	you	probably	already	know	how	to	outline	font,	but	keep	reading	anyway	because	there
are	some	extra	steps	you	can	do	to	finalize	the	outlines.	Note:	All	screenshots	from	this	tutorial	are	taken	from	Adobe	Illustrator	CC	Mac	version.	Windows	or	other	versions	can	look	different.	The	most	common	way	is	to	convert	text	into	outlines,	but	there	are	other	ways,	for	example,	you	can	use	the	Shape	Builder	Tool	to	turn	paths	into	text	vectors,
or	even	trace	handwriting	from	paper	using	the	Pen	Tool.	Before	converting	the	text	to	an	outline,	I	highly	recommend	duplicating	the	text	because	once	you	create	an	outline,	you	wont	be	able	to	change	the	character	style	or	font.	Now	follow	the	steps	below	to	vectorize	text.	Step	1:	Select	the	text	you	want	to	vectorize.	Step	2:	Use	the	keyboard
shortcut	Shift	+	Command	+	O	(or	Shift	+	Ctrl	+	O	for	Windows	users)	to	outline	the	font/text.	If	youre	not	comfortable	with	using	shortcuts,	you	can	also	right-click	on	the	selected	text	and	choose	Create	Outlines.	When	you	create	outlines,	the	live	text	becomes	a	shape.	Youll	see	anchor	points	if	you	select	them	with	the	Direct	Selection	Tool.	That
means	you	can	edit	the	text	as	you	would	edit	a	shape.	If	you	use	brushes	to	create	text	in	Adobe	Illustrator,	they	are	already	vectorized,	but	they	are	strokes,	not	shapes,	so	youll	need	to	convert	them	to	shapes.	Follow	the	steps	below	to	see	how	it	works.	Step	1:	Select	the	strokes	(text)	you	created	using	the	brushes	and	go	to	the	overhead	menu
Object	>	Path	>	Outline	Stroke.	And	youll	see	that	the	path	became	outlines	but	there	are	overlapping	shapes	in	between	the	strokes.	Now	its	time	to	use	the	Shape	Builder	Tool	to	combine	shapes.	Step	3:	Select	the	outlines	and	choose	the	Shape	Builder	Tool	from	the	toolbar	or	activate	it	using	the	keyboard	shortcut	Shift	+	M.	Simply	draw	through
the	highlighted	shapes	until	all	overlapping	areas	are	gone.	In	the	end,	the	text	should	look	like	this,	without	overlapping	outlines.	Now	yes,	youve	successfully	created	the	text	vector.	Now	if	you	want	to	vectorize	handwritten	text,	thats	another	story	because	its	more	complicated	and	it	takes	a	lot	of	time.	Follow	these	steps	to	vectorize	your
handwritten	text	in	Adobe	Illustrator.	Step	1:	Scan	your	handwriting	and	open	it	in	Adobe	Illustrator.	If	you	dont	have	a	scanner,	you	can	take	a	picture	too.	As	long	as	you	have	the	handwriting	outlines	very	clearly,	it	will	work	because	the	idea	is	to	trace	the	handwriting	using	the	Pen	Tool.	Step	2:	Choose	the	Pen	Tool	from	the	toolbar	or	activate	it
using	the	keyboard	shortcut	P.	Start	tracing	the	letters	you	need	one	at	a	time.	If	youre	not	familiar	with	the	Pen	Tool,	feel	free	to	look	at	my	Pen	Tool	tutorial	where	I	talked	about	the	steps	and	tracing	tips.	Step	3:	Once	you	finish	tracing	the	letters,	you	should	get	a	closed	path,	and	youve	already	vectorized	the	text.	You	can	finalize	the	text	using	the
Shape	Builder	Tool	to	combine	the	overlapping	areas	and	add	a	fill	color.	The	cool	thing	about	this	method	is	that	you	can	vectorize	your	handwritten	text	and	make	your	own	custom	font,	but	you	need	to	use	one	of	the	font	design	tools	to	create	fonts.	Depending	on	what	you	have	in	hand,	choose	the	method	according.	For	example,	if	you	have	typed
text,	use	Method	1,	if	you	created	text	using	brushes,	use	Method	2,	and	if	you	want	to	vectorize	text	from	handwriting,	Method	3	is	the	go-to.	As	a	graphic	designer,	you	may	need	to	create	files	in	a	format	suitable	for	use	with	a	Cricut	machine.	The	open	SVG	(Scalable	Vector	Graphics)	file	format	is	one	of	the	best	formats	to	create	content	for	a
Cricut.	So	how	do	you	make	SVG	files	for	Cricut	in	Adobe	Illustrator?	You	first	need	to	open	Illustrator	and	start	a	new	document.	After	this,	you	should	add	text,	create	outlines	and	unite	the	text.	When	youre	done,	save	the	SVG	file	and	after	that,	you	should	upload	it	to	your	Cricut	design	space.	In	this	tutorial,	I	will	walk	you	through	creating	an
SVG	file	from	scratch	using	Illustrator.	Once	you	have	completed	this	tutorial,	you	can	create	svg	images	for	any	project	you	want.	Here	is	a	step-by-step	guide	to	creating	an	SVG	file	in	Illustrator:	The	first	step	is	to	open	Illustrator.	You	can	choose	File	>	New	to	create	a	new	document	or	open	up	an	existing	one.	Once	your	file	is	open,	you	can	start
creating	your	design.	The	new	file	should	be	a	12	x	12	square	canvas	with	a	resolution	of	300	dpi.	This	will	give	you	the	optimal	size	and	quality	for	your	final	vector	image.	Once	your	canvas	is	open,	you	can	begin	adding	text	to	it.	You	can	use	any	font	or	style	that	you	want	for	this	step.	Adobe	will	use	your	system	fonts	but	you	can	also	upload	a	fancy
cursive	font.	When	creating	an	SVG	file,	the	most	important	thing	is	to	make	sure	that	your	text	is	editable.	This	means	it	must	be	converted	to	outlines.	To	convert	the	text	to	outlines,	you	can	select	it	and	then	choose	Create	Outlines	from	the	Type	menu.	Alternatively,	you	can	press	Command	+	Shift	+	O	on	a	Mac	or	Ctrl	+	Shift	+	O	on	Windows.
This	will	ensure	that	your	text	is	editable	as	a	vector	object	in	the	SVG	file.	The	next	step	before	saving	your	SVG	file	is	to	unite	the	text.	The	unite	tool	is	the	first	top-left	option	under	shades	modes.	This	step	is	important	because	it	will	ensure	that	all	text	is	combined	into	one	object.	This	will	help	to	keep	your	final	SVG	file	organized	and	clean.	Now
youre	ready	to	save	your	file	as	an	SVG.	To	do	this,	choose	File	>	Save	As	from	the	top	menu	bar.	Then,	select	SVG	from	the	list	of	formats	and	save	your	file.	Once	you	have	saved	your	SVG	file,	you	can	upload	it	to	your	Cricut	Design	Space.	This	will	allow	you	to	use	your	design	in	any	projects	you	create	with	a	Cricut	machine.	Using	this	method
youll	be	able	to	create	text	cut	files.	But,	you	can	use	these	same	steps	to	create	image	files	too.	I	get	commissions	for	purchases	made	through	some	of	the	links	in	this	post.	There	is	no	extra	cost	to	you.	See	my	full	disclosure	here.	Adobe	Illustrator	is	a	popular	design	software	but	there	are	different	ways	to	create	digital	files.	For	example,	if	you
prefer	to	use	a	mobile	device	to	design,	you	can	see	my	post	on	7	apps	for	making	svg	files	for	a	variety	of	options.	There	are	even	some	online	programs	like	Canva	that	let	you	save	as	an	svg	file	type.	What	is	the	best	way	to	convert	a	PNG	to	SVG?	The	best	way	to	convert	png	files	to	svg	format	in	Adobe	Illustrator	is	to	simply	upload	the	file.	Png
images	will	automatically	be	converted	to	svg	designs.	Its	a	good	idea	to	save	your	new	project	so	that	you	can	use	it	again	later.Fonts	are	one	of	the	easiest	ways	to	make	SVG	files!	In	this	tutorial,	youll	learn	to	make	an	SVG	from	a	font,	which	fonts	work	well	(and	which	ones	dont!),	and	how	to	prepare	your	files	so	they	cut	on	a	cutting	machine.
Welcome	back	to	my	series	on	using	Adobe	Illustrator	for	SVG	design!	Weve	gone	over	the	basic	workspace	and	an	overview	of	paths,	anchor	points,	and	handles.	Today	we	get	to	the	fun	stuffactually	designing	some	SVG	files	using	basic	fonts	in	Adobe	Illustrator!	Note:	this	is	an	updated	version	of	this	SVG	Design	in	Adobe	Illustrator	post.	This	post
is	updated	with	the	newest	version	of	Adobe	Illustrator	and	has	more	information	than	the	old	post.	Were	going	to	be	diving	into	the	world	of	creating	SVG	files	with	fonts.	This	tutorial	is	going	to	be	broken	into	two	parts	since	there	is	a	lot	we	can	do	when	it	comes	to	using	fonts.	Well	cover	the	basics	today	and	then	some	more	advanced	font
techniques	in	the	next	tutorial.	By	the	end	of	this	post,	youll	be	able	to	export	a	font-based	SVG	and	use	it	with	your	cutting	machine!	As	always,	I	encourage	you	to	use	keyboard	shortcuts!	They	will	speed	up	your	workflow	and	youll	be	much	faster	at	creating	your	SVG	designs.	I	use	shortcuts	in	this	lesson	in	parentheses.	Ive	gone	into	more	detail
about	the	tools	were	using	in	previous	lessons,	so	definitely	start	at	the	beginning!	Note:	Between	the	last	lesson	and	this	lesson,	I	upgraded	to	Adobe	Illustrator	(Version	28).	Not	much	has	changed,	but	if	you	notice	differences,	this	is	why.	Want	a	video	tutorial	of	this	entire	post?	I	walk	you	through	making	SVGs	using	fonts	in	this	video!	Just	click
play.	Or	read	on	for	a	written	tutorial!	Want	access	to	this	free	file?	Join	my	FREE	craft	library!	All	you	need	is	the	password	to	get	in,	which	you	can	get	by	filling	out	the	form	below.	The	file	number	is:	P121.	Prefer	a	video	about	how	to	make	an	SVG	with	a	font?	Hit	play	below!	If	youd	like	a	written	tutorial,	keep	reading!	Open	up	a	new	document	(I
go	through	this	in	the	workspace	overview,	if	you	havent	read	through	that	already).	Type	Your	Text	Select	the	Text	tool	(T).	Lets	start	by	creating	some	basic	text	on	your	art	board.	You	can	choose	whatever	word	you	would	like,	but	for	this	instance,	make	it	a	single	word	or	a	name.	It	will	be	pretty	small	because	our	artboard	is	12	x	12.	Resize	Your
Text	There	are	two	easy	ways	to	change	the	size	of	your	text.	Holding	the	shift	key	(this	will	keep	your	sizing	proportional),	click	and	drag	on	one	of	the	corner	anchor	points	to	increase	the	size.	See	my	post	on	paths,	anchor	points,	and	handles	for	more	information.	Or	increase	the	font	size	either	in	the	Control	Panel	at	the	top	or	in	the	Properties
Panel	if	you	have	that	open	on	the	left.	Just	make	your	text	large	enough	that	you	can	easily	work	with	it.	Remember	that	vector	files	can	be	resized	to	any	size	without	losing	resolution,	so	the	actual	size	isnt	super	important	here.	Now	you	can	choose	a	font	ysing	the	font	dropdown	in	the	.	You	will	know	its	a	font	because	it	has	a	blue	underline,
instead	of	an	outline	around	it.	For	this	tutorial,	Im	using	the	Luckily	font,	which	is	part	of	the	Font	Bundles	Plus	subscription.	I	have	an	absolutely	bonkers	number	of	fonts	on	my	computer.	Check	out	my	post	Where	to	Find	Cheap	and	Free	Fonts	for	the	Cricut	to	find	more	fonts	to	work	with.	Lately,	Ive	been	loving	both	the	Font	Bundles	and	Creative
Fabrica	subscriptions	for	fonts.	Both	memberships	are	inexpensive	and	you	get	access	to	tons	of	great	fonts.	Now	if	we	tried	to	export	this	file	as	is,	you	wouldnt	be	able	to	upload	it	to	Cricut	Design	Space	or	another	design	software.	That	is	because	the	font	is	still,	well,	a	font.	And	you	cant	upload	fonts	to	cutting	machine	software.	We	need	to	outline
the	font	to	turn	it	into	a	shape.	Make	sure	you	have	your	text	exactly	how	youd	like	it	and	you	have	no	typosonce	you	outline	your	fonts,	theres	no	editing	your	text.	Note:	before	you	do	this	step,	scroll	down	to	the	section	on	saving	your	SVG.	I	like	to	save	a	version	of	my	file	with	the	fonts	un-outlined	so	I	know	what	fonts	I	used	in	my	file.	You	may
want	to	do	this	too.	Choose	the	Select	tool	(V)	and	click	on	your	word.	Then	use	the	Create	Outlines	shortcut	shift+control+O	(PC)	/	shift+command+O	(Mac).	You	can	also	go	to	to	the	menu	bar	at	the	top	and	go	to	Type	>	Create	Outlines.	Now	when	you	click	on	your	text,	youll	see	a	thin	blue	outline	around	each	letter.	Each	individual	letter	is	now	a
shape.	If	you	double	click	on	one	of	the	letters,	it	will	isolate	and	you	can	move	it	individually.	Sometimes	I	do	this	to	help	my	kerning	(well	talk	about	this	next	week!)	or	change	up	the	design	a	bit.	To	get	out	of	isolation	mode,	double	click	on	the	artboard.	Now	if	we	exported	our	image	as	is	and	uploaded	it	to	Cricut	Design	Space	or	another	cutting
machine	software,	our	letters	would	still	be	individual	letters	in	the	Layers	Panel	and	would	cut	as	individual	letters	on	the	mat,	as	you	see	below.	Yes,	you	could	weld	or	unite	within	Cricut	Design	Space,	but	its	much	easier	to	make	your	image	correctly	in	Illustrator	so	you	dont	have	to	do	those	sorts	of	edits	in	the	cutting	machine	software.	In	the
workspace	overview,	I	talked	about	the	Pathfinder	panel.	If	you	went	through	that	lesson,	your	Pathfinder	panel	should	be	on	the	right	side	in	the	Panels	menu	(go	back	to	that	lesson	and	add	it	if	not).	It	looks	like	two	overlapping	squares.	Click	on	that	icon	to	open	the	Pathfinder	panel.	From	here,	click	and	select	your	word	(V)	and	then	choose	the
first	icon	in	the	Pathfinder	panel	that	looks	like	two	combined	squares.	If	you	hover	over	this	icon	it	will	say	unite.	Click	the	icon	and	Illustrator	will	unite	your	word	into	a	single	image.	The	final	step	in	the	design	is	to	create	a	compound	path.	In	my	lesson	on	paths,	anchor	points,	and	handles,	I	mentioned	how	compound	paths	are	important	to	SVG
design.	This	is	one	of	the	ways	that	we	keep	all	of	the	parts	of	a	design	together	so	they	cut	on	the	same	mat	properly.	For	some	simple	designs,	this	step	isnt	necessary.	But	for	many	designs	it	is,	so	its	good	to	get	in	the	habit	of	creating	a	compound	path	now.	Select	your	word	(V)	and	use	the	keyboard	shortcut	control+8	(PC)	/	command+O	(Mac).
You	can	also	go	to	Object	>	Compound	Path	>	Make	in	the	menu	bar	at	the	top.	The	look	of	your	shouldnt	wont	change	in	this	instance,	but	youll	see	the	image	is	now	a	compound	path	in	the	Layers	panel,	as	youll	see	in	a	few.	Sometimes	youll	create	a	compound	path	and	it	will	look	like	your	image	disappears	(especially	if	you	skip	the	uniting	step).
Really,	its	just	filled	with	no	color.	You	should	still	be	able	to	click	on	the	image	using	the	Select	tool	(V)	and	then	you	can	use	the	color	picker	to	change	the	color	back	to	something	you	can	see.	I	have	a	full	tutorial	on	color	coming	soon!	Before	we	export	our	file,	I	like	to	look	in	the	Layers	panel	to	make	sure	everything	looks	correct.	I	always	check
the	Layers	Panel	because	it	can	show	you	if	you	have	issues.	You	can	click	and	drag	the	left	edge	of	the	Layers	panel	to	make	the	panel	wider	so	you	can	see	the	names	of	the	layers.	In	the	Layers	panel,	you	can	see	that	we	have	a	single	layer	that	has	our	compound	path	text	shape.	This	is	what	we	want	for	a	single-layer	SVG.	If	we	had	more	layers,
wed	expect	to	see	them	here	as	compound	paths	as	well.	If	you	see	anything	other	than	the	single	compound	path,	you	can	investigate.	Maybe	you	have	other	text	on	your	artboard	or	in	the	gray	area	outside	your	artboard.	Maybe	you	didnt	make	the	compound	path	properly.	Maybe	you	have	a	stray	anchor	point	or	line.	If	you	click	the	circle	to	the
right	of	the	layer,	it	will	select	that	object	on	your	canvas	so	you	can	investigate.	You	can	also	rename	your	layers.	This	is	not	necessary	but	can	be	a	nice	step,	especially	once	we	get	into	making	multi-layer	SVG	files	or	if	you	want	to	share	or	sell	your	files.	Just	click	on	the	name	of	the	layer	and	type	your	new	name.	Then	when	you	upload	your	SVG	to
your	software,	the	name	of	the	layer	will	appear	in	the	Layers	panel.	Its	time	to	export	our	SVG!	Heres	my	process.	You	can	skip	the	first	step	if	youd	like,	but	I	find	it	helpful.	Before	I	outline	my	text,	I	save	my	project	(control+S	(PC)	/	command+S	(Mac))	as	a	basic	.ai	file	(this	is	the	default	and	stands	for	Adobe	Illustrator).	For	this	one,	I	named	it
hello.ai.	This	way,	because	my	text	is	still	in	font	form,	I	will	always	know	what	fonts	I	used	for	my	SVG.	Once	its	outlined,	you	lose	access	to	the	font	name.	And	I	cant	tell	you	how	many	times	people	have	asked	me	what	font	is	that?	or	Ive	wanted	to	use	a	font	a	second	time	and	had	no	idea	what	font	it	was.	Having	the	.ai	file	with	the	un-outlined	font
is	so	helpful	to	remember.	Once	you	have	the	.ai	file	saved,	you	can	Save	As	(shift+control+S	(PC)	/	shift_command+S	(Mac).	From	the	dropdown,	choose	the	SVG	file	type	(.svg).	Give	your	file	a	name	and	hit	Save.	In	the	next	screen,	youll	see	some	options.	Dont	mess	with	any	of	them.	Just	hit	OK	and	your	SVG	file	will	save!	Now	you	have	a	working
SVG	file	that	you	can	upload	to	your	cutting	machine	software.	An	important	note	about	using	fonts	(or	any	elements!)	in	your	SVG	design.	Cricut	and	Silhouette	machines	prefer	simple	artwork.	And	by	this	I	mean	that	the	machine	software	prefers	fewer	anchor	points.	Again,	if	you	skipped	last	weeks	lesson,	go	back	because	theres	important
information	in	there	about	anchor	points!	These	machines	can	cut	incredibly	intricate	designs,	but	the	moremathematicallysimple	they	are	(the	fewer	anchor	points	they	have),	the	better.	The	easiest	way	to	see	your	fonts	anchor	points	is	by	looking	at	your	font	once	youve	outlined	it	(see	above	for	outlining	instructions).	Youll	see	that	the	Luckily	font
I	used	is	simple	and	has	a	reasonable	number	of	anchor	points.	But	if	I	choose	a	rough	font,	like	Midnight	below,	youll	see	that	it	has	TONS	of	anchor	points!	Your	cutting	machine	is	really	going	to	struggle	with	something	this	complexit	will	chew	up	your	material	as	it	tries	to	turn	and	cut	at	all	of	these	anchor	points.	This	is	just	something	to	be
aware	of	when	youre	working	with	fonts.	You	want	smooth,	easily	cuttable	fonts.	Stay	away	from	fonts	with	rough	or	grunge	and	sometimes	even	brush	in	the	name.	Always	check	your	anchor	points	after	youve	outlined	to	make	sure	your	font	is	a	good	one	for	cutting.	If	you	do	have	a	font	that	isnt	super	rough	but	it	still	has	a	lot	of	anchor	points,
theres	a	tool	you	can	use	to	help	remove	some	of	those	anchor	points	while	maintaining	your	font	shape.	This	makes	for	faster,	easier	cutting.	For	example,	I	have	the	font	Author	here.	When	outlined,	its	a	bit	anchor-heavy,	so	lets	simplify	it.	Select	your	image	(V)	and	then	go	to	the	top	menu	bar	and	go	to	Object	>	Path	>	Simplify.	This	will	give	you	a
small	slider	that	you	can	slide	back	and	forth	to	simplify	your	font.	Slide	to	the	left	and	youll	have	fewer	anchor	points,	slide	to	the	right	and	youll	have	more.	You	want	to	try	and	find	the	point	on	the	slider	where	your	font	looks	the	same	as	it	does	originally,	but	with	fewer	anchor	points.	You	dont	want	to	slide	the	slider	so	far	to	the	left	that	it	starts
to	distort	your	font	in	the	simplification.	If	you	click	on	the	three	dots	on	the	right,	youll	get	some	more	advanced	options,	but	I	like	that	you	can	see	here	how	many	anchor	points	you	started	with	and	how	many	you	have	now.	Its	just	interesting	information!	I	started	with	249	points	and	ended	with	82	points	and	my	text	looks	the	same.	Amazing,
right?	For	todays	lesson,	practice	making	an	SVG	with	a	font!	Make	a	bunch	of	them!	Also	try	outlining	different	fonts	you	have	to	see	how	many	anchor	points	they	have.	You	may	want	to	start	a	spreadsheet	of	good	and	bad	fonts	that	you	can	refer	to	so	youre	not	constantly	choosing	the	same	font	and	finding	out	its	not	going	to	work	as	a	cut	file.
And	thats	it	for	todays	font	lesson!	Next	week,	were	going	to	dive	deeper	into	fonts.	Were	going	to	talk	a	bit	more	about	good	font	design,	processes	and	elements	like	kerning,	ligatures,	and	line	spacing,	as	well	as	creating	multi-layer	font	SVG	files.	Its	going	to	be	funcant	wait	to	go	through	it	with	you!	Scott	Falkner	Community	Expert	,	Jan	28,	2022
Jan	28,	2022	Text	is	a	vector,	but	fonts	cannt	be	embedded	in	SVG	files.	You	can	save	as	PDF	or	convert	text	to	outlines	then	save	as	SVG.	It	would	help	to	know	what	you	plan	to	do	with	the	file.	What	format	do	you	need	it	to	be	in?	What	will	be	done	with	the	file?	Jump	to	answer	Home	Tutorials	How	to	Create	SVG	file	in	Adobe	Illustrator	Before	we
create	SVG	file,	lets	review	the	use	case!What	is	an	SVG	file,	and	how	to	use	it?SVG	files,	which	stand	for	Scalable	Vector	Graphics,	are	essential	for	website	design	as	they	provide	high-quality,	scalable	images	that	can	be	resized	without	losing	quality.	This	format	is	handy	for	your	websites	logos,	icons,	and	illustrations.SVG	files	also	have	a	smaller
file	size	than	other	image	formats,	resulting	in	faster	loading	times	for	your	web	pages.Additionally,	using	SVG	files	can	improve	your	websites	accessibility	and	search	engine	optimization	(SEO)	by	following	the	guidelines	provided	by	the	search	engines.What	Tools	do	I	need?Creating	an	SVG	file	for	your	website	can	be	done	with	vector	graphic
software	like:Adobe	IllustratorPhotoshopCorel	DrawIf	you	are	comfortable	and	experienced	with	coding,	you	can	code	it	yourself	through	your	preferred	code	editor	software.Okay,	lets	get	to	Illustrator	and	create	SVG	file	like	a	pro!Tutorial:	Create	SVG	file	in	Adobe	IllustratorStep	1:If	you	are	looking	to	create	SVG	file	and	use	it	on	your	website,
then	open	up	any	logo/illustration	in	a	.ai	or	.eps	fileKeep	in	mind,	just	because	you	can	do	something	on	Illustrator	or	even	Photoshop,	doesnt	mean	that	the	SVG	file	will	also	be	able	to	do	it.	If	youre	working	with	a	wide	variety	of	blend	modes,	gradients,	or	highly	unusual	fonts,	it	may	not	work	in	SVG.The	first	thing	to	do	is	click	on	File	>	Save	As.
Decide	where	you	want	to	save	it	on	your	computer	and	give	it	whatever	name	you	choose.Next,	in	the	Format	box,	choose	SVG.	Then,	click	Save.	After	you	save	it,	a	dialog	box	will	pop	up	to	give	you	various	options.Click	on	the	button	in	the	lower	left-hand	corner	labeled	More	Options	to	see	the	entire	range	of	options	to	set	up	the	file.Ensure	that
your	SVG	Profiles	say	SVG	1.1,	and	under	Fonts	>	Type,	the	default	will	always	be	SVG	since	that	is	what	you	are	creating.The	next	option,	Fonts	>	Subsetting,	has	several	choices	you	can	decide	on.If	you	want	to,	you	can	select	the	default	to	System	Fonts,	which	will	provide	you	with	replacement	fonts	in	the	system.	In	the	above	screenshot,	you	can
see	that	there	are	other	choices	as	well	for	Fonts	>	Subsetting.If	you	choose	Only	Glyphs	Used	or	All	Glyphs,	this	will	take	the	fonts	that	you	have	used	and	put	them	within	the	SVG	file	(however,	this	wont	always	work).To	try	to	combat	that,	you	can	go	back	to	the	Type	section,	and	instead	of	selecting	the	default,	you	can	choose	Convert	to
Outline.This	is	an	alternative	choice	to	embedding	the	font.	However,	it	does	make	the	file	less	accessible	because	it	will	no	longer	be	in	a	text	form.It	can	also	make	it	into	a	larger	file	size.Note:	If	you	want	to	make	your	SVG	file	more	accessible,	read	our	tutorial	on	How	to	Make	Your	SVG	File	Accessible	for	Screen	Readers.Step	3:Next,	to	keep	it
simple,	in	the	Advanced	Options	>	CSS	properties,	choose	Presentation	Attributes.Also,	check	the	Responsive	option.	This	is	hugely	important	because	this	selection	deletes	the	width	and	height	in	the	XML	code	of	your	SVG	file.Turning	on	Responsive	allows	the	file	to	be	responsive	to	any	screen	size	and	ignore	the	image	width	and	height	properties.
Click	OK	in	the	lower	right-hand	corner	to	create	a	size-responsive	SVG	file.After	finalizing,	its	a	good	practice	to	go	back	and	double-check.	So,	open	the	file	and	double-check	that	its	how	you	want	it	to	be.And	thats	all	there	is	to	it!	Once	you	have	created	an	SVG	file,	the	only	issue	is	that	it	wont	be	fully	optimized,	coming	right	out	of	whatever
program	you	created.So,	the	next	step	is	to	optimize	it	properly.To	do	that,	read	our	step-by-step	tutorial	on	optimizing	an	SVG	file	to	load	your	file	faster.	Want	to	make	your	own	SVG	cut	files?	One	of	the	most	important	steps	is	to	convert	text	to	outlines	and	save	as	a	vector	file.	Ill	show	you	How	to	Vectorize	Text	in	Illustrator	in	just	a	few	easy
steps!	Soon,	youll	be	making	your	own	SVG	files	for	Cricut	and	Silhouette	machines!How	to	Vectorize	Text	in	IllustratorIf	you	want	to	learn	how	to	vectorize	text	for	crafting,	you	will	love	this	easy	tutorial!	I	use	these	exact	steps	nearly	every	day	to	create	all	of	my	SVG	files.	I	will	show	you	how	to	place	text	in	Illustrator,	convert	it	to	a	vector	file,	and
share	easy	tips	for	creating	quality	SVG	files!What	is	a	Vector	Graphic?Vector	graphics	are	an	important	part	of	creating	your	own	cut	files	for	your	Cricut	or	Silhouette.	A	vector	file	uses	mathematical	formulas	to	create	shapes	with	lines	and	curves.	In	comparison,	a	raster	graphic	is	comprised	of	tiny	little	squares	called	pixels.What	are	the
Differences	Between	a	Raster	File	and	Vector	File?The	image	quality	of	raster	files	is	dependent	on	the	number	of	pixels	per	square	inch	(resolution).	Raster	images	are	used	for	detailed	digital	artwork,	photography,	or	images	used	for	display	only.The	quick	way	to	visualize	how	they	are	made	is	to	take	a	very	small	raster	image	and	make	it	very
large.	It	will	become	blurry!	A	raster	file	is	saved	as	.jpg	file	or.	gif	file,	among	others	file	types.In	contrast,	vector	graphics	can	be	resized	up	or	down	without	a	loss	of	quality.	They	do	not	depend	on	the	resolution	of	where	they	are	displayed.	Because	of	this,	they	are	used	for	line	art	graphics.RELATED	POST:	How	to	Upload	Fonts	to	Cricut	Design
SpaceFor	the	best	results,	you	will	want	to	use	vector	graphics	to	create	cut	files.	They	are	smaller	files,	which	are	smaller	for	everyone	to	download	and	store	on	their	computers.	Vector	graphic	elements	are	usually	saved	as	an	AI	file,	SVG	file,	EPS	file,	or	DXF	file.What	is	a	SVG	File?A	SVG	file,	or	scalable	vector	graphic,	is	a	type	of	vector	image
that	is	used	by	Cricut	Design	Space	and	Silhouette	Studio.	Additionally,	Silhouette	Studio	performs	well	with	.dxf	files.You	can	even	use	SVG	files	for	laser	cutting	machines	such	as	the	xTool	M1.	Its	my	new	favorite	(affordable!)	laser	machine	for	crafts!These	design	programs	tell	your	electronic	cutting	machine	what	to	cut	based	on	the	SVG	design.
As	you	change	the	size,	the	integrity	of	the	design	will	remain	the	same.	Plus,	SVG	files	maintain	separate	layers	so	that	your	Cricut	or	Silhouette	knows	which	color	to	cut	different	design	elements	from!When	you	design	a	SVG	file	with	fonts,	you	will	need	to	vectorize	the	text.	You	will	create	outlines	of	the	text	to	convert	the	font	into	vector	format.If
youre	new	to	using	SVG	files	with	your	Cricut	machine,	make	sure	you	read	my	full	post	onHow	to	Upload	an	SVG	to	Cricut	Design	Space.How	to	Create	Text	Outlines	in	IllustratorAdobe	Illustrator	is	the	premier	professional	design	program	for	graphic	designers	and	cut	file	designers.	And	theres	a	Free	Trial	for	it	over	at	Adobe!	There	are	other
design	programs	out	there	(including	a	couple	of	free	ones),	but	their	capabilities	are	limited	in	comparison	to	Illustrator.Dont	worry,	you	can	turn	fonts	into	a	vector	object	with	a	simple	process!	Its	the	first	step	to	designing	your	own	SVG	files,	and	I	will	show	you	how	easy	it	is	in	this	step	by	step	tutorial.First,	open	a	new	document.	If	you	are
creating	an	SVG	file,	I	would	recommend	a	1212	art	board.	That	is	the	size	of	a	standard	cutting	mat	for	a	Cricut	or	Silhouette	machine.Use	the	type	tool	to	create	a	text	layer.	The	text	tool	will	create	an	editable	layer	of	text	you	can	change	the	text,	font	size,	or	font	style	as	much	as	you	want.To	turn	the	text	into	a	vector	shape,	select	all	of	your	text
using	the	Selection	Tool	(V,	Open	Arrow).	Your	text	elements	will	be	surrounded	by	a	blue	line	box.The	next	step	is	to	go	to	the	top	menu	and	click	Type	>	Create	Outlines.	The	keyboard	shortcut	to	create	outlines	of	text	in	Illustrator	is:	Shift	+	Command	+	O	for	Mac;	Shift	+	Control	+	O	for	PC).With	those	simple	steps,	your	text	characters	are
vectorized!	To	see	the	anchor	points	in	your	text	outline,	use	the	Direct	Selection	Tool	(A,	Closed	Arrow).Repeat	steps	for	additional	text.Tips	to	Convert	Text	to	Outlines	in	IllustratorIf	you	are	planning	to	create	cut	files	with	your	text,	here	are	some	tips	you	should	follow:1.	Some	fonts	are	more	appropriate	to	use	for	vector	cut	files	than	others.	The
best	way	to	verify	how	well	your	text	will	cut	is	to	use	the	Direct	Selection	Tool.2.	The	number	of	dots,	or	anchor	points,	that	a	font	has	is	directly	correlated	to	the	number	of	cuts	or	corners	that	your	Cricut	or	Silhouette	will	make.	Fewer	anchor	points	=	less	corners	and	smoother	cut.	More	anchor	points	=	more	cuts	and	more	detail.3.	You	can
usually	tell	if	a	font	will	translate	well	to	a	cut	file	by	looking	at	the	edges	of	the	letters.	For	example,	a	watercolor	brush	font	will	never	cut	as	cleanly	as	a	font	with	clean	edges	(as	in	Times	New	Roman).Font	designers	that	design	fonts	to	be	used	with	cutting	machines	will	be	aware	of	this.	Nearly	all	fonts	in	Design	Space	or	Silhouette	Studio	will	cut
cleanly,	but	if	you	use	your	own	fonts	you	will	have	to	check	the	outlines	manually.4.	If	you	can,	definitely	choose	a	font	with	fewer	anchor	points.	You	will	be	guaranteed	a	clean	cut,	which	is	especially	important	when	cutting	small	letters	and	details.5.	Once	you	have	vectorized	your	text,	you	will	have	editable	paths	but	NOT	editable	text.	You	can	not
change	the	font	after	you	create	outlines.	You	can	however	change	the	size	as	much	as	you	would	like.	Remember	your	font	is	now	powered	by	math!	You	can	enlarge	it	without	losing	any	quality.6.	If	you	plan	to	cut	all	or	some	of	your	text	from	one	material	or	color,	I	recommend	taking	this	process	one	step	further	to	create	a	more	user	friendly	file.
Select	all	of	the	text	that	will	be	the	same	color	and	in	the	same	area	(a	whole	word	or	phrase).	Then	create	a	compound	path	by	selecting	Object	>	Compound	Path	>	Make	(Command	+	8	or	Control	+	8).	Then	select	the	new	path	and	fill	color	if	needed.7.	When	you	have	finished	your	vector	outline,	you	can	save	your	illustrator	in	SVG	format	to	cut.
I	usually	keep	two	files:	one	as	a	working	Illustrator	file,	and	the	other	as	a	SVG	file	type	that	is	ready	to	cut.	You	now	have	your	own	design	file	from	text	to	use	with	your	cutting	machine!Pin	How	to	Create	a	Text	Vector	File
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